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This protocol describes a method to visualise ligands distributed across a field of cells. The ease of expressing exogenous proteins, together

with the large size of their cells in early embryos, make Xenopus laevis a useful model for visualising GFP-tagged ligands. Synthetic mRNAs are
efficiently translated after injection into early stage Xenopus embryos, and injections can be targeted to a single cell. When combined with a lineage
tracer such as membrane tethered RFP, the injected cell (and its descendants) that are producing the overexpressed protein can easily be followed.
This protocol describes a method for the production of fluorescently tagged Wnt and Shh ligands from injected mRNA. The methods involve

the micro dissection of ectodermal explants (animal caps) and the analysis of ligand diffusion in multiple samples. By using confocal imaging,
information about ligand secretion and diffusion over a field of cells can be obtained. Statistical analyses of confocal images provide quantitative
data on the shape of ligand gradients. These methods may be useful to researchers who want to test the effects of factors that may regulate the
shape of morphogen gradients.

Video Link

The video component of this article can be found at http://www.jove.com/video/53162/

Introduction

During early embryonic development, cells are progressively committed to follow specific lineages of differentiation: this means a group of
totipotent (or pluripotent) cells become gradually restricted to establishing populations of progenitor cells determined to give rise to one cell
type. Cell-cell signalling is central to the regulation of lineage specification during embryonic development. Manipulation of these signals will be
required to direct stem cells toward particular fates to support novel medical treatments.

A relatively small number of signalling pathways are reiterated during development, including pathways responding to the TGF superfamily
(nodals and BMPs)1'2, FGFs®, Wnts4, and Hedgehogs5. These secreted proteins bind receptors present on the cell membrane to activate

signal transduction thereby altering gene expression and/or cell behaviour. The tight regulation of cell signalling is essential for cell lineage
specification and normal development. While the cross-talk among these pathways is important in determining cell fate, a single ligand can itself
elicit distinct responses at different concentrations. Morphogen gradients were described over 100 years ago as a theory to explain how different
cell types can derive from a field of cells®. Signalling molecules produced by one group of cells may diffuse over a certain range, decreasing

in concentration with a greater distance from the source. Cells exposed to the signal will respond to the local concentration at their position in
the field of cells, with cells at distinct positions responding differently to different levels of the signal. Evidence for the existence of morphogens
comes from studies of the early Drosophila embryo7 and the wing disc?, as well as the vertebrate limb® and neural tube®.

Methods are needed to investigate how morphogen gradients are established and to identify other molecules important in regulating these
gradients. Elegant experiments using immunohistochemistry to visualise endogenous proteins in vivo in the context of different genetic
backgrounds have been used to investigate morphogen gradients”“. However, good antibodies and specific mutants are not always available,
so we describe here a protocol using overexpression of fluorescent ligands in Xenopus, to provide an alternative, simple method to dissect how
exogenous gene products can influence distribution of ligands across a field of cells. Xenopus laevis provides an excellent system to undertake
these types of experiments as their embryos develop externally so they are accessible at the earliest stages. Their large size (1-1.5mm in
diameter) simplifies microinjection and surgical manipulation and by blastula stages the cells are easy to image as they are still relatively big
(about 20um across). Overexpression studies in Xenopus are simple to do: mRNA injected into the early embryo can be targeted to particular
cells and is efficiently translated.
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The fluorescently tagged Wnt8a/Wnt11b-HA-eGFP constructs were generated using pCS2 Wnt8a-HA'®, pCS2 Wnt11b-HA™ and eGFP. The HA
peptide is important to include, not only to provide an additional molecular tag, but also because it is thought to act as a spacer separating the
Wnt and eGFP proteins allowing both gene products to function. The construct used for the visualisation of Shh was previously used to generate
a transgenic mouse expressing a Shh-eGFP fusion protein15; this was kindly provided by Andy McMahon. Importantly, the GFP tag for all the
constructs is cloned 3’ to the signal sequence such that it is retained after processing. It is also essential to ensure that the final protein includes
sequences required for modifications, such the addition of lipids as is the case for Shh and Wnt ligands.The cDNAs were subcloned into the
pCS2+ expression vector which is optimised for the prodution of synthetic mRNA,; it includes an SP6 promoter and polyadenylation signal (http://
sitemaker.umich.edu/dlturner.vectors).

The work described here provides a simple protocol for comparing the secretion and diffusion of fluorescently tagged Wnt and Shh tagged
ligands. By injecting defined amounts of synthetic mMRNA, the protocol circumnavigates any problems associated with variable expression
from different vectors using different promoters. These methods have recently been applied to investigate the effects of the heparan sulfate
endosulfatase Sulf1 on Shh-eGFP and Wnt8a/Wnt11b-HA-eGFP secretion and diffusion in Xenopus1 T,

Ethics statement: Animal experiments were done under a UK Home office licence to MEP and the experiments carried out was approved by the
University of York ethics committee in compliance with the ARRIVE (Animal Research: Reporting of In Vivo Experiments) guidelines. (https://
www.nc3rs.org.uk/arrive-guidelines).

1. Strategy to Generate Fluorescently Tagged Ligands

Below is an example protocol for subcloning Wnt8a-HA and eGFP into pCS2, in order to produce the in frame fusion construct Wnta-HA-eGFP:

1. Set up and run PCR reactions for Wnt8a-HA and eGFP. Use the primer information displayed in Table1 and the Example PCR reaction and
Example PCR conditions displayed in Table 2. Note: Template DNA will vary depending on the construct being produced, in this example,
Whnt8a-HA is used as template DNA.

2. Clean up PCR reactions using a gel extraction kit, perform final elution in 30pl of molecular grade water.

3. Check 2 pl of PCR product on a 1% agarose gel prepared in TAE.

4. Digest Wnt8a-HA and eGFP PCR products and pCS2 using the appropriate restriction enzymes (see Table 1), set up reactions as described
in Table 2 (Example PCR product digest).

5. Incubate reactions for 3 hr at 37°C and then store Wnt8a-HA and GFP PCR products on ice.

6. Add 1yl of calf alkaline intestinal phosphatase (CAIP) to pCS2 digest and incubate for 6 min at 37°C.

7. Heat inactivate CAIP by incubating for 15 min at 65°C.

8. Run pCS2 and PCR digests on an 1% ultrapure agarose gel prepared in TAE.

9. Gel extract and clean up pCS2 and PCR products using a gel extraction kit, perform final elution in 30pl of molecular grade water.

10. Set up ligation as described in Table 2 (Example T4 ligation) and incubate at 12°C for 16 hr.

2. mRNA Synthesis: Generating the Template

1. Produce templates using restriction enzyme digestion of the following plasmids (all in the expression vector pCS2): membrane-Cerulean
(memCerulean), membrane-RFP (memRFP), Shh-GFP, Wnt8a/Wnt11b-HA-eGFP.
1. Set up restriction digests as described in Table 2 (Example template digest).
2. Mix gently and incubate the reactions for 2 hr at 37°C.

2. Run 2.5 pl of digested plasmid on a 1% agarose gel (TAE) to check that the reaction has cut to completion.
3. Clean up the digests using a gel extraction kit, perform final elution in 50 ul of molecular grade water.

3. mRNA Synthesis: In Vitro Transcription

1. Synthesize functional mMRNA using the SP6 mRNA transcription kit. Assemble the reactions in 1.5 ml DNAse/RNAse free microcentrifuge
tubes.

2. Set up mRNA transcription reactions as described in Table 2 (Example mRNA synthesis).

3. Mix the reactions gently with a pipette and then incubate at 37°C for 4 hr.

4. Check 1 pl of the reaction on a 2% agarose gel (TAE).

5. Add 1 pl of DNAse to the reaction, mix gently with a P20 and incubate the reaction for a further 15 min at 37°C.

6. Add 340 pl of molecular grade water, 40 pl of ammonium acetate and 400 pl of phenol-chloroform to the reaction. Vortex the reactions for 30
sec.

7. Spin the mRNA for 5 min, 14,000 x g, 4°C.

8. Pipette the top (aqueous) layer from each reaction moving it to a fresh 1.5 ml screw cap microcentrifuge tube.

9. Add an equal volume of chloroform to each of the decanted reactions. Vortex the samples for 30 sec.

10. Spin the mRNA for 5 min, 14,000 x g, 4°C

11. Pipette the top aqueous layer from each reaction moving it to a fresh 1.5 ml screw cap microcentrifuge tube.

12. Add an equal volume of isopropanol to each of the reactions and precipitate the mRNA at -80°C for 30 min.

13. Spin each of the reactions for 15 min at 14,000 x g, 4°C to pellet the mRNA

14. Remove the supernatant taking care not to disturb the pelleted mMRNA

15. Add 200 pl of 70% ethanol to each of the reactions, mix the reactions and then spin for 10 min at 14,000 x g, 4°C.

16. Remove the ethanol taking care not to disturb the mRNA, dry the pellet at room temperature using a vacuum desiccator or speed-vac.
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17. Re-suspend the mRNA in 10-20 pl of molecular grade water. Spin briefly and keep the samples on ice. Note: Heating the sample to 80 °C for
1 min can help it dissolve.

18. Run 1ul of mMRNA on a 2% agarose gel (TAE) and analyse 1.2 pl on a spectrophotometer to get an accurate readout of concentration.
CRITICAL STEP: A concentration of 400 ng/ul of synthetic mRNA is required to carry out the following experiments.
CRITICAL STEP: If the 260/280 ratio is outside of the range of 2.00-2.20, or the total amount of MRNA exceeds 12 pg, carry out a lithium
chloride precipitation.

19. Store mRNA in 1 pl aliquots at -80°C. Use aliquots and then throw away; do not re-freeze mRNA.

4. Generating Xenopus laevis Embryos

1. Prime Xenopus laevis females by subcutaneous injection with 50 units of human chorionic gonadotropin hormone (HCG; Chorulon) a week
before the experiment.

2. Induce Xenopus laevis females the night before the experiment by injecting 250 units of HCG and incubating them in the dark, O/N at 19 °C.

3. Dissect out testes from euthanised male frog and store in 1XNAM at 4°C. Note: Male frog is euthanised by terminal anaesthesia in
accordance with Schedule 1 of Animals (Scientific Procedures) Act 1986 (https://www.nc3rs.org.uk/euthanasia).

4. Massage female Xenopus laevis to induce ovulation, collect the laid eggs in a 55 mm diameter round petri dish.

5. Produce a sperm suspension by crushing 2 of a Xenopus laevis testis in 1 ml of deionised water.

6. Brush Xenopus oocytes with the crushed sperm suspension using a Pasteur pipette and pipette bulb. CRITICAL STEP: Perform fertilisation
reactions at approximately 4:30pm on the day of the experiment.

7. Culture embryos at 21°C in NAM/10 (see Table 3 for solutions) in 55 mm petri dishes coated with 1% agarose diluted in water (water).

8. De-jelly embryos after 45 min using cysteine/HCL (Table 3). Note: At 21°C, embryos will reach the 2 cell stage after 90 min and cleave every
20 min after that.

5. Microinjecting Xenopus Embryos

1. Using 1 X 90mm glass capillaries and a Narishige PC-10 dual-stage glass micropipette puller, pull micropipettes for injections. Adjust settings
empirically to achieve a fine tip (less than one micron diameter).

2. Attach a micropipette (needle) to a gas microinjector (for instance, the Harvard Appartaus PLI-100 PICO-INJECTOR) to repeatedly deliver
precise volumes of liquid by applying a regulated pressure for a digitally set period of time. Adjust the pneumatic pressure to deliver a volume
of 1.25 to 10 nanolitres as determined using a reticle or calibration slide.

3. Coat a 55 mm petri dish with 5 ml of 1% agarose (water). Cut a 35-35 mm square of agarose out of the dish, this will provide a stable surface
to microinject embryos.

4. Transfer embryos into NAM/3 + Ficoll (Table 3) and move to injection dish.

5. Inject embryos in the animal hemisphere once they reach the required stage for the experiment.

1. To analyse the distribution of GFP tagged ligands on the cell surface, inject the embryos bi-laterally at the two cell stage, 10nl per cell.
Example mRNA dilutions shown below for Wnt8a-HA-eGFP. CRITICAL STEP: Ensure that all mMRNA concentrations start at 400 ng/ul.
Note: The amount of MRNA to be injected needs to be determined empirically by testing concentrations and finding the minimum
amount needed to visualise the fluorescent ligand. Western blotting using an anti-HA antibody is an essential step to determine that the
mRNAs are translated to similar levels in order to allow the comparison of two different fluorescently tagged ligands; we have done this
for Wnt8a-HA-eGFP and Wnt11b-HA-eGFP in Fellgett et al., 2015.

Note: When assessing the effect of an injected mRNA (such as one coding for a candidate regulator), a typical control is to inject a
non-active RNA, such as LacZ, into sibling embryos in order to control for any effects of the additional transcripts in the embryo.

Dilute memRFP mRNA 1 in 4 (1ul + 3ul dH,0) with molecular grade water to reduce the concentration to 100 ng/ul.

Dilute Wnt8a-HA-eGFP mRNA 1 in 4 (1ul + 3pl dH,0) with molecular grade water to reduce the concentration to 100 ng/ul.

Mix memRFP mRNA in a 1:1 ratio with Wnt8a-HA-eGFP mRNA.

Mix mRNA from 5.5.1.3 in a 1:1 ratio with either the control mMRNA LacZ or a modulator such as Sulf1.

Inject embryos bilaterally at the 2 cell stage with 10nl of mMRNA per cell (total of 20nl). Note: This results in 250 pg of memRFP,

250 pg of Wnt8a-HA-eGFP, 500 pg of Wnt11b-HA-eGFP and 2 ng of LacZ or Sulf1 mRNA being injected into each cell.

arON =

2. To analyse the diffusion of GFP tagged ligands, inject mMRNA coding for ligand-GFP together with a lineage marker such as memRFP
at the 16-32 cell stage, 1.25 nl per cell.

3. To analyse the effects of any potential modulator of ligand diffusion, co-inject MRNA coding for the modulator together with the ligand
and lineage tracer. Alternatively, inject neighbouring cells: one with mRNAs coding for the GFP-tagged ligand and a lineage tracer
(memRFP) and the other with mRNAs coding for the modulator and a different lineage tracer (memCerulean).

6. Transfer embryos to a 12.5°C incubator and culture until the following day, Nieuwkoop and Faber (NF) stage 8.

6. Excising Animal Cap Explants

1. Transfer embryos to a 55 mm petri dishes coated with 5 ml of 1% agarose (water). Fill the dish with NAM/2 (Table 3).

Take circular animal caps using Tungsten needles. CRITICAL STEP: Take large caps at this stage as these will heal better and be easier to
image, keep control caps to ensure no convergent extension occurs.

3. Transfer animal explants to 55 mm petri dishes coated with 1% agarose (water) and culture embryos at 21°C for 4 hr. CRITICAL STEP:The 4
hr incubation is required to allow fluorescent proteins to mature.

4. Generate relief slides by sticking down two layers of PVC insulation tape onto microscope slides. Cut a 14 mm by 10 mm rectangle out of the
tape to leave a chamber for mounting animal caps. CRITICAL STEP: Flatten both layers of tape thoroughly onto the slide before cutting the
rectangle.

5. Pipette 2 separate droplets of NAM/2 (Table 3) into the relief slide, approximately 30 ul per drop.
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Transfer animal explants to the relief slides using a cut off P20 tip and orientate so that the apical side faces upwards. Note: Each slide can
hold 10-15 animal caps. CRITICAL STEP: At this stage the animal caps should have partially healed, this means they are less delicate and
can be orientated using forceps.

Gently lower a glass cover slip onto the relief slide and allow the cover slip to dry for 20 min. CRITICAL STEP: The size of the animal cap is
crucial; ensure the cap is big enough that when the glass coverslip is lowered onto the relief slide it compresses the apical layer of animal cap
cells enough to produce a flat surface to image. If the animal caps are too small still then reduce the PVC tape to one layer.

Seal the slide using nail varnish. CRITICAL STEP: Do not use too much nail varnish to seal the relief slides because if the PVC tape
becomes too damp it will raise up and ruin the slide.

Dry relief slides for 20 min in the dark and they are ready to image, typically animal caps will remain healthy for 4-6 hr once sealed in the
slide.

7. Imaging

Note: Imaging was carried out using an inverted confocal microscope. Lambda mode was chosen for imaging as this allowed multiple
fluorophores with overlapping signatures to be used, and removed the problem of potential sample movement between scans.

1.
2.

® NGO R W

Find explants using a low magnification objective then switch to 63x/1.4 oil objective for higher resolution imaging.

Switch on requisite lasers; for this example the 405 laser was used to excite memCerulean, the 488 laser was used to excite GFP and the
561 laser to excite memRFP using 405 and 488/561 dichroic mirrors.

Use lambda mode (In Zen 2011, select lambda mode — 32 bins).

Select the 405nm, 488nm and 561nm lasers.To permit a wider field of view, zoom out the image (to 0.6x).

Set the frame size to the desired image size (1024 x 1024 with pixel sizes of 220nm was used for this data set).

Set averaging to typically 4 to 8 to increase the signal to noise ratio.

Optimise the pinhole (1 airy unit according to the 561nm laser was used for this data set).

Optimise the laser powers. CRITICAL STEP: Balance the 405nm, 488nm and 561nm lasers such that all fluorophores can be detected using
the 32 detector array whilst minimising the amount of voltage and gain required.

Collect the light being emitted from memCerulean, GFP and memRFP. For this work light was collected every ~10nm from 415-720nm,
although larger collection intervals are also possible (e.g., every ~20 nm).

8. Image Analysis

1.

Investigating the effects of modulators on the cell surface expression of GFP-tagged ligands
NOTE: The following steps are a detailed guide of how the analysis was performed in our laboratory. The end user may want to streamline
the process by writing an ImagedJ or FIJI script to remove some of the manual steps.
CRITICAL STEP: It is important the end user samples the spectra of any fluorophores used in the same conditions that the final experiment is
performed in order to perform effective spectral unmixing of the multiple fluorophores used in the final experiment.
Two main types of analysis are performed in this section:
1. Calculating the total number of Wnt-HA-eGFP pixels co-localising with the cell membrane.
1. Unmix the green, red and cerulean channels using spectra sampled from single injections of these fluorophores in ZEN software.
Save these images as separate LSM documents to use in all of the following steps.
2. Open LSM files directly in image editing software. Note: The following instructions are for FIJI Image J.
3. Save the LSM images as image sequence documents, this will automatically split the images into the separate channels.
4. Save the image sequence into the same folder as the scripts for the script analysis software that will be used to analyse the
data(see supplemental code files for actual script). Note: The following instructions are for Matlab.
5. Open up the script analysis software and open the directory in which the scripts are written.
6. Enter the file name under Location analysis, the software will take the file name and perform the analysis.
Note: The file names will read ImageA0000 and ImageA0001 for each image. The script analysis software will use the image
marked 0001 as the mask and analyse the percentage of pixels in image 0000 that co-localise with this mask.
7. Take the percentage co-localisation number (annotated as Cell membrane populated) and copy this to a spreadsheet. Note: The
following instructions are for Excel.
8. Plot the percentage co-localisation number on a bar chart either as an absolute or relative value.

2. Analysing the number, size and shape of Wnt-HA-eGFP puncta.

1. Open unmixed LSM files directly in image editing software. Note: the following instructions are for FIJI Image J.

2. Split each image into its separate channels (Image > Colour > Split channels).

3. Threshold both the Wnt-HA-eGFP and the membrane marker channels (Image > Adjust > Auto-threshold). CRITICAL STEP: Try
a number of thresholds to see which one produces a representative image, without overexposing the channel.
Convert the membrane marker channel to a mask (Process > Binary > Make mask).
Invert this mask (Edit > Invert).
Convert the Wnt-HA-eGFP puncta to a mask as above.
Subtract the membrane marker mask from the ligand-GFP mask (Process > Image calculator > Wnt mask in top box, membrane
mask in bottom box).
Use the analyse particle function. From here, select the required parameters and analyse the data (Analyse > Analyse particles).
Copy the number of particles, average particle size and circularity data into a spreadsheet and then plot graphs from these data.
Note: For this analysis, only particles between 0.1-10;.|m2 size were analysed, no restrictions were placed on particle circularity.
This instruction is for Excel.

Nookr
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2. Analysing the range of ligand diffusion

1. Open up all unmixed images in confocal imaging software and then export the files in a TIF format, as raw data and as an RGB image.
Note: This instruction is for Zen lite 2011.CRITICAL STEP: Include a scale bar on at least one of the images so that distance can be
calculated during the analysis.

2. Open the images to be analysed in image analysis software. Note: The following instructions are for Photoshop.8.2.3) Right click on the
background of the image and select ‘layer from background’, to create a new layer.

3. Set the membrane marker channels to 0, so that only the ligand-GFP channel is visible (Layer > New adjustment layer > Channel
mixer). CRITICAL STEP: Clip the new adjustment layer to the image being analysed, the option to clip the new layer to this image is
available as a tick box after clicking on the channel mixer option.

4. Open a new workspace. Set the resolution to 300 pixels per inch and the colour mode to RGB colour (File > New > Clipboard).

5. Copy all of the images being analysed into the single workspace (Click on the image and it's clipped channel mixer by holding control
then hold control and Alt and drag the image into the workspace).

6. Orientate all of the images so that the maximum length of diffusion for each image can be measured along the horizontal axis, with the

cells expressing Wnt-HA-eGFP orientated to the left.

Save the work space as a TIF and then open this in the image analysis software. Note: The following instructions are for FIJI Image J.

Open the ROI manager window (Analyse > Tools > ROl manager).

Draw a rectangle on the first image, the exact size of the rectangle can be specified (Select rectangle tool and draw any rectangle >

Edit > Selection > Specify). Note: A size of 650 x 100 pixels length x width was used in this study.

10. Position the rectangle on the very edge of the domain expressing Wnt-HA-eGFP. Place the rectangle over the region with the maximum
distance of Wnt-HA-eGFP diffusion. CRITICAL STEP: Even without the membrane marker the regions expressing Wnt-HA- eGFP
should be visible due to background fluorescence; if not then consult raw images.

11. Shift the box 10 pM to the right. Determine the number of micrometres by measuring the length of the scale bar included in one of the
images (Draw a line tracing the scale bar > Analyse > set scale). Note: This provides a value for 10 uM in pixels.

12. Add the box to the ROl manager by pressing the add button in ROl manager window.

13. Move rectangle to the next image to be measured by clicking back on the rectangle tool to move the rectangle. Repeat steps 8.2.10-11.

14. Once all of the panels have been measured, select multiplot from the ROl manager menu (ROl manager > More > Multiplot > List).
Note: the data represents Wnt pixel intensity (Y) with increasing distance along the horizontal axis (X, measured in Pixels). The value
for Y is the average signal intensity of ligand-GFP at the point X and the average is calculated from all of the pixels in the Y axis for
each X value. Consequently the taller the box, the more pixels will be analysed to produce this average. A small box (in the Y axis) will
be noisier; a tall box will have very low average pixel intensity.

15. Copy the data from the multiplot box into a spreadsheet and re-label accordingly. Note: The following instructions are for Excel.

16. Discard the first 10-20pum of data from each analysis as this represents background fluorescence from ligand-GFP expressing cells and
distorts the graphs.

17. Open up scientific analysis and graphing software and create a new notebook. Note: The following instructions are for Sigmaplot 13.

18. Label the required number of columns for the data by double clicking on the horizontal numbers on the worksheet and labelling them
distance in ym, Wnt8a-HA-eGFP and Wnt11b-HA-eGFP.

19. Copy data from the spreadsheet into the relevant columns in the scientific analysis and graphing software.

20. Create a scatter graph (Create graph > Scatter > Multiple scatter > Select X many Y > Select the distance column for X > Select
Wnt8a-HA-eGFP and Wnt11b-HA-eGFP for the Y values > Finish).

21. Perform regression analysis on Wnt8a-HA-eGFP curve by left clicking on a Wnt8a-HA-eGFP point on the scatter graph. All of the
points should highlight. Click on Analysis > Regression wizard.

22. Select the curve equation category (Exponential decay) and the equation name (Single, 3 parameter) then press next.

23. Select the X and Y values to which the curve should be fitted (if the data was highlighted previously, this should be done automatically)
then press next.

24. Continue through the wizard until the Numeric Output options page, ensure ‘create report’ is ticked then press next. Note: The
parameters for the fitted curve will be shown in Report 1*.

25. On the Graph options page ensure ‘add equation to graph title’ is ticked then press finish. Note: The wizard will have created Report 1*
and Graph 1* tabs at the top of the note book. In addition the curve will have been added to the graph produced in (8.2.20).

26. Repeat steps 8.2.21-8.2.25 to fit a curve for Wnt11b-HA-eGFP. CRITICAL STEP: try fitting multiple equation categories and equation
names to the data. Note: The curve with the best fit should produce the highest R? value with the lowest residual sum of squares.

Representative Results

Confocal analysis of animal cap explants expressing fluorescently tagged proteins provides an effective system for visualising ligand distribution
under different experimental conditions. In one example, the distribution of GFP tagged Shh is shown (Figure 1). At the 2-cell stage, Xenopus
embryos are injected into both cells with either with a control mMRNA or with mRNA coding for Sulf1, an enzyme that modifies cell surface
heparan sulfate and influences the Shh morphogen gradient16. These embryos are cultured until the 32-cell stage and a single cell is co-injected
with mRNAs coding for Shh-GFP and memRFP (as a lineage tracer). This creates a clone of cells expressing Shh-GFP that is marked with the
cell membrane tethered RFP. At the blastula stage, animal cap explants are taken for analysis by confocal microscopy. Figure 1 shows that
under control conditions, Shh-GFP is secreted and diffuses outside of the region expressing the injected mMRNAs. However, in the presence of
Sulf1, Shh-GFP is more restricted in its distribution and, in this sample, is not detected outside the clone of cells producing it. The effects of Sulf1
on Shh-GFP distribution has been analysed more fuIIy16.

©o®N

When expressed in Xenopus embryos, fluorescently tagged Wnt ligands are secreted, accumulate on the cell membrane, and diffuse across

the field of cells. In Figure 2, we characterise the quantitaive and qualitative properties of the two different fluorecently tagged Wnt ligands in

cells injected and expressing the proteins. Figure 2A-H shows examples of how Wnt8a and Wnt11b-HA-eGFP accumulate on the membrane
of animal cap cells. By comparing panels 2B and 2F it is clear that Wnt8a-HA-eGFP accumulates more efficiently on the cell membrane than

Wnt11b-HA-eGFP. Quantitative information has been extracted from the confocal images using a combination of image and script analysis
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software (supplemental code file). Figure 2l shows the relative accumulation of Wnt8a-HA-eGFP on the cell membrane compared to Wnt11b-
HA-eGFP. The data was obtained using a computer script that determines the total number of Wnt-HA-eGFP pixels co-localising with cell
membrane pixels in each image. In another approach, the total number of Wnt-HA-eGFP puncta that co-localise with the cell membrane are
counted using image analysis software (Figure 2J). Qualitative information about the size and shape of individual puncta can also be extracted
from the data using image analysis software. In addition to fewer Wnt11b-HA-eGFP puncta co-localising with the cell membrane (Figure 2J)
these puncta also have a smaller average size than Wnt8a-HA-eGFP puncta (Figure 2K). Moreover, Wnt11b-HA-eGFP puncta have a reduced
circularity compared to Wnt8a-HA-eGFP puncta (Figure 2L). Circularity is a measure of how closely an object resembles a perfect circle, with 1
representing a perfect circle and 0.1 an elongated non-circular shape. This approach can be used to test any candidate regulator of Wnt ligand
diffusion. To do this, control cells should be injected with a control mMRNA coding for an inactive form of the candidate regulator or an irrelevant
protein such as beta-galactosidase (/lacZ); this provides a more valid control than simply not injecting the regulator. Data in these examples was
analysed using the non-parametric test Mann-Whitney U A statistical analysis programme was used to perform the test.

In Figure 3, we investigate Wnt ligand diffusion. A single blastomere was injected at the 4-cell stage such that the animal cap explants represent
a field of cells in which only some cells express either Wnt8a-HA-eGFP or Wnt11b-HA-eGFP. By including a cell lineage tracer, we can identify
expressing versus non-expressing cells and this allows the range of Wnt8a-HA-eGFP and Wnt11b-HA-eGFP ligand diffusion away from

the source cells to be analysed (Figure 3B and 3C). Due to the curvature of the animal cap explants, the maximum distance that could be
reliably measured using this assay was 160um, which was not enough to measure the absolute distance of ligand diffusion. However, by

using a combination of confocal analysis, image analysis and scientific analysis and graphing software the overall shape of the Wnt-HA-eGFP
morphogen gradient could be analysed (Figure 3D). This data can be used to investigate whether overexpressing another protein together with
the tagged ligands in the same cells can affect Wnt secretion or diffusion. In another type of experiment (Figure 3E-3J) the effects of a potential
regulator in receiving cells can be measured by overexpressing the candidate protein in clones of cells adjacent to cells expressing Wnt8a or
Wnt11b-HA-eGFP. This allows any non-cell-autonomous effects of the regulator on Wnt-HA-eGFP ligand diffusion to be examined. Consistent
with Figure 2, more Wnt8a-HA-eGFP can be detected diffusing away from cells than Wnt11b-HA-eGFP in both diffusion experiments.

The types of experiments described in this paper have been used to analyse the effect of Sulf1 on Shh and Wnt signalling16’17.

Shh-GFP

+Sulf1

‘Shh-GFP '

Figure 1. Modulation of Shh-GFP distribution can be detected by confocal analysis of Xenopus animal caps. (A) A cartoon depicting
experimental assay where embryos are first injected with mRNA coding for Sulf1 or a control mRNA, the same embryos are later injected at

the 32-cell stage with mRNA coding for Shh-GFP into a single cell. (B-C) Animal cap explants were taken at stage 8 and imaged after 4 hr.
Images are shown at the edge of a Shh-GFP + memRFP expressing clone of cells. In control embryos (B), Shh-GFP is distributed away from the
memRFP marked clone of signal producing cells. In embryos expressing Sulf1 (C), Shh-GFP is more restricted in its distribution, see'®. memRFP
is shown in magenta and Shh-GFP in green. Scale bars represent 20 um. Please click here to view a larger version of this figure.
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Figure 2. Quantitative and qualitative analysis of Wnt8a and Wnt11b-HA-eGFP puncta on the cell membrane. (A-H) Embryos were
microinjected bi-laterally with mRNA encoding memRFP (500 pg) into the animal hemisphere at the two cell stage. In addition embryos were
injected with mRNA encoding (A-D) Wnt8a-HA-eGFP (500 pg) or [E-H] Wnt11b-HA-eGFP (1ng). The embryos were also injected with mRNA
coding for LacZ to provide a control for additional mRNA/protein when analysing the effects of any potential regulator. The white boxes in (C)
and (G) mark the areas enlarged in panels (D) and (H) respectively. The total amount Wnt-HA-eGFP fluorescence co-localising with the cell
membrane was calculated using image and script analysis software and then normalised (l). Qualitative information was extracted using image
analysis software. Wnt8a and Wnt11b-HA-eGFP punctae were analysed for particle number (J), particle size (K) and particle circularity (L).
Mann-Whitney U (**P<0.01), N=number of embryos. memRFP is shown in magenta, and Wnt8a/11b-HA-GFP is shown in green, scale bars
represent 20pm. Please click here to view a larger version of this figure.
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Figure 3. Measuring the range of diffusion of fluorescently tagged Wnt ligands. (A) Diagram depicting the assay used to measure Wnt8a
and Wnt11b-HA-eGFP secretion and diffusion away from expressing cells. (B-C) mRNA encoding (B) memCerulean (600 pg), LacZ (4ng) and
Wnt8a-HA-eGFP (2ng) or (C) memCerulean (600 pg), LacZ (4ng) and Wnt11b-HA-eGFP (2 ng) was injected into the animal hemisphere of
one blastomere at the four cell stage. (D) The range of diffusion of Wnt8a-HA-eGFP and Wnt11b-HA-eGFP was measured through a control
background. (E) Diagram depicting the assay used to measure Wnt8a and Wnt11b-HA-eGFP diffusion through a background expressing LacZ,
see method for details. (F-G) mRNA encoding memCerulean (600 pg) and (F and H) Wnt8a-HA-eGFP (2 ng) or (G and I) Wnt11b-HA-eGFP
was injected into the animal hemisphere of one blastomere at the four cell stage. An adjacent blastomere was injected with mRNA encoding
memRFP (600 pg) and LacZ (4 ng) see Key for details. (J) The range of Wnt8a-HA-eGFP and Wnt11b-HA-eGFP diffusion was measured
through a background expressing LacZ. The data was quantified and plotted using confocal analysis, image analysis and scientific analysis and
graphing software. memCerulean (blue (C-D) and Yellow (F and H)), Wnt-HA-eGFP (green), memRFP (magenta), scale bars represent 20 um.
Please click here to download a larger version of this file.

Primer name
eGFP forward

eGFP reverse

Shh-GFP forward
Shh-GFP reverse
WnitBa-HA-GFP forward
WnitBa-HA-GFP reverse
Wnt11b-HA-GFF forward
Wnit11b-HA-GFF reverse

Bold text marks restriction enzyme sites
Underlined text marks Kozak sequences
Red text marks start codons
Blue text marks stop codons

Primer sequence (5' to 3) Restriction site
AGAGAGCTCGAGATGGTGAGCAAGGGCGAGGAGCTG Xho1
CTCTCTTCTAGAT TACTTGTACAGCTCGTCCATGCC Xbai

AGAGAGGAATTCACCATGGTGCTGCTGGCCAGATG EcoR1
AGAGAGGTCTAGA | CAGCTGGACTTGACCGCCATICC Xbai
AGAGAGGGATCCACCATGGAAAACACCACTTTGTTCATC 3 BamH1

CTCTCTCTCGAGAGCATAATCTGGAACATCATATGG Xho1
AGAGAGGAATTCACCATGGCTCCGACCCGTCACTGGGTT EcoR1
CTCTCTCTCGAGTGCGTAGTCTGGGACGTCGTATGG Xho1

Table 1. Primers used to subclone Wnt8a/Wnt11b-HA-eGFP and Shh-GFP into pCS2.

Reaction

Components

Example CS2+ digest

1.5 pg of pCS2+

2 pl of Restriction enzyme 1

2 pl of Restriction enzyme 2
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5 pl of Restriction enzyme buffer (10X)

Made up to 50 pl with molecular grade water

Example mRNA synthesis

2 pl linearised template

2 ul 10x Megascript trx mix

2 pl 50mM ATP

2 pl 50mM CTP

2 pl 50mM UTP

2 ul 5mM GTP

2.5 pyl 40mM Cap Analog (m7G(5")

2 pl SP6 enzyme mix

3.5 yl Molecular grade water

Example PCR reaction

0.5 pl High fidelity DNA polymerase (2,000
units/ml)

2 ng Template DNA

2.5 pl of forward and reverse primers (10uM)

0.5 pl of dNTPs

5 pl of DNA ploymerase buffer (10X)

Made up to 50 pl with molecular grade water

Example PCR conditions

Intial denaturation 2 min at 98 °C

15 sec 98 °C

15 sec 65 °C

30 cycles

40 sec 72 °C

Final extension 10 min at 72 °C

Example PCR product digest

28 pl of PCR product

2 pl of Restriction enzyme 1

2 pl of Restriction enzyme 2

5 pl of Restriction enzyme buffer (10X)

13 pl Molecular grade water

Example T4 ligation

1 ul Cut CS2+

3 pl Cut PCR product 1

3 pl Cut PCR product 2

1 ul of T4 DNA ligase

1 pl T4 DNA ligase buffer (10X)

1 yl Molecular grade water

Example template digest

5 ug Plasmid DNA

10 pl Restriction enzyme buffer (10X)

3 pl Not1 (except Shh-GFP, Kpn1 is used)

Made up to 100 pl with molecular grade water

Table 2. Example reaction conditions used for subcloning and producing synthetic mRNA for Wnt8a-HA-eGFP.

Solution

Components

Cysteine-HCL

0.1X NAM

2.5% L-cysteine hydrochloride monohydrate (pH7.8)

NAM salts

110 mM NaCL
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2 mM KClI

1 mM CA(NO3)2

0.1 mM EDTA

NAM/2 0.5X NAM salts

5 mM HEPES pH7.4

0.25 mM Bicarbonate

25 ug/ml Gentamycin

NAM/3 + Ficoll 0.33X NAM salts

5 mM HEPES pH7.4

0.25 mM Bicarbonate

2 5ug/ml Gentamycin

5 % Ficoll

NAM/10 0.1X NAM salts

5 mM HEPES pH7.4

25 ug/ml Gentamycin

Table 3. Solutions used during the production and microinjection of Xenopus laevis embryos.

An essential part of this protocol is generating biologically active ligands that are normally processed, secreted, and able to elicit a response in
the receiving cell, despite having a fluorescent moiety attached. It is critical to establish that the fluorescently-tagged gene product is biologically
active using an appropriate assay. For Shh-GFP, the ability to activate the expression of ptc1 was confirmed'®. Wnt8a has a remarkably potent
ability to induce a secondary axis when expressed in a single ventral blastomere2°'21, and Wnt8a-HA-eGFP was shown retain this biological
activity. Wnt11b inhibits activin treated ectodermal explants from undergoing convergent extension21'22, and Wnt11b-HA-eGFP also retains its
biological activity17. The ability of the tagged ligands to elicit responses equivalent to the untagged proteins suggests that the conclusions based
on experiments using the fluorescent ligands will be relevant to the normal protein. The addition of the HA epitope between the ligand and the
fluorescent protein provided a spacer region that allows the Wnt constructs to be both active and fluorescent.

The maijor limitation of this type of analysis is that it does not directly inform on endogenous morphogen gradients. For instance, the diffusion

of Shh across the field of cells in animal cap may not reflect the way endogenous Shh moves through the columnar neural epithelium in the
embryo. However, the simplicity of this protocol allows experiments where the effect of exogenous regulators on the distribution of ligands can be
tested. The results from these approaches can form the basis of hypotheses to be tested using more demanding in vivo analyses. For instance,
the ability of over-expressed Sulf1 to restrict the distribution of Shh-GFP using the methods described in this paper pointed to the potential

for Sulf1 in modulating the Shh morphogen gradient. This was directly tested and validated using antisense morpholino knock-down of Sulf1

and immunocytochemistry to visualise endogenous Shh in the neural tube'®. A similar method to ours has been used to investigate specific
mechanisms that could regulate ligand diffusion. Smith and colleagues demonstrated that a GFP-tagged nodal (Xnr2) used simple diffusion, and
not cell extensions (cytonemes) or transcytosis (using vesicles) to form a gradient23.

Further elaborations of these methods are possible where other proteins that block particular pathways can be expressed in targeted cells to
investigate whether a response to the signalling molecule is needed as an intermediary to relay signals from one cell to another. For instance,
expressing a dominant negative activin receptor between the source of activin and the responding cells showed that simple ligand diffusion could
elicit a response several cell diameters away from the source even with non-responsive cells in between®*. This conclusion was supported by
work in zebrafish where wild tyye cells can respond to a source of nodal, despite being surrounded by non-responsive mutant cells lacking an
essential co-receptor for nodal ®. Other studies have used zebrafish to investigate diffusion of fluorescently tagged Iigandszs‘zg. Some studies
has observed that epitope tagging the C-terminus of Wnt proteins can impact on signalling activity, possibly because of the highly conserved
cysteines that contribute to protein conformation. Our previous work has shown that including a spacer (such as the HA tag) results in tagged
Whnt ligands that are biologically active'’. This is likely because the spacer provides flexibility needed for ligand —receptor interaction, such as in
the thumb-forefinger model of Wnt-Frz binding3°.

The next step for advancing our studies is to include a visual readout for the activation of the signalling pathway. For instance, expressing GFP-
tagged DVI?® in cells distant from the source of ligand will allow the range across which Wnt11b has ability to signal to be measured. The range
of Wnt8a signalling activity could be shown using antibody staining to measure nuclear localisation of b-catenin in cells* at a distance from the
source. These types of experiments are possible using the techniques described in this paper. By employing a variety of different fluorescent
proteins or fluorophores, an additional level of information would be provided where one not only measures the distribution of a ligand but the
also the output of the signalling pathways, and in this way determining the threshold range of a morphogen.

Xenopus laevis is a useful model for visualising GFP-tagged ligands and further details on the methods for procuring embryos, mRNA synthesis,
microinjection and dissection are available®".
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